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 ThermoMicroscopes Disclaimer

The ThermoMicroscopes Nanolithography option enables you to design and implement

lithography techniques. Components other than those supplied by ThermoMicroscopes

may be required for the design and the implementation of lithography techniques.

Note that with the design and the implementation of lithography techniques, there is risk

of damage to the instrument and to the hardware components not supplied by

ThermoMicroscopes. ThermoMicroscopes reserves the right to decide, at our discretion,

if an instrument failure is due to workmanship and thus covered under warranty, or if the

failure is induced by improper use of the AutoProbe instrument and the Nanolithography

option.  In the case of the latter, repair will not be covered under warranty and the

customer will be charged at the prevailing time and material rates.

The Nanolithography option requires the AutoProbe Extended Signal Access Package

(eSAP) low-voltage module (LVM) for use with AutoProbe M5 instruments and for use

with AutoProbe CP and LS instruments without an EC/Norm switch on the rear panel of

the base unit. Using the LVM, the user can open any signal path to alter input and output

signals, or to inject user-defined signals.  There is risk of damage to the instrument since

the LVM makes it possible to modify input and output signals.

Note that these instructions do not pertain to the low-voltage SAM, model # APCT-

1000-001, which has safety and configuration considerations that differ from the

eSAP LVM.  If using the low-voltage SAM with Nanolithography, refer to the

AutoProbe Signal Access Module Operation and Reference Guide for details on safety

and configuring and connecting the low-voltage SAM.

Read all instructions before installing.  Before installing, removing, or

reconfiguring the LVM TURN OFF THE POWER.

When using the LVM, take all appropriate precautions to ensure that the

operator is never exposed to voltage.

Call the Customer Support Department at (408) 747-1600 with any safety or operating

questions you may have when installing or using the Nanolithography option and the

LVM.
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Introduction

These operating instructions describe Nanolithography, an optional extension to your

AutoProbe CP, LS, M5, VP2, or VP system.  The Nanolithography option includes

software and the AutoProbe Extended Signal Access Package (eSAP) low-voltage

module (LVM), if required.  The Nanolithography option can be used to develop

lithography techniques specific to your application, for instance modifying a

photoresistive surface that has been deposited on a substrate.  Lithography techniques can

be developed using AFM or STM mode.

The following topics are covered in these operating instructions:

♦  a section that describes the installation and the setup of the Nanolithography option

♦  a tutorial that describes modifying a surface using a common lithography technique

♦  a software reference chapter that describes the features and the controls of the

Nanolithography software

These operating instructions assume that you are familiar with your AutoProbe system

and that you know how to operate in AFM and STM modes.  If you are new to

AutoProbe, refer to the User’s Guide that is appropriate for your system.

Note: The instructions in this document that refer to AutoProbe CP are applicable to

AutoProbe LS instruments as well.  The instructions in this document that refer

to AutoProbe VP2 are applicable to AutoProbe VP as well.
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About Nanolithography Techniques

The Nanolithography option is used to design lithography in AFM or STM mode specific

to your application. There are two lithography techniques that can be developed with the

Nanolithography option: 1) voltage-pulse lithography; and 2) z scanner-movement

lithography.

Voltage-pulse lithography uses short or long duration voltage/current pulses that are

applied between the tip and the sample to modify the sample surface.  Voltage-pulse

lithography results in the deposition of some barrier contaminants at an x, y location on

the surface.  Voltage-pulse lithography is performed with the z feedback loop on or off.

Note:  Voltage-pulse lithography can only be performed in STM mode with AutoProbe

VP2 instruments.

Z scanner-movement lithography uses a voltage signal that is applied to the scanner,

causing the scanner to extend in the z direction.  There are two key parameters that must

be defined for z scanner-movement lithography: 1) the scanner extension distance; and 2)

the force with which the scanner extends. Z scanner-movement lithography is performed

with the z feedback loop off.

Note: The lithography technique you wish to develop may require hardware

components, including electronics, other than those provided by

ThermoMicroscopes.
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Setting Up Nanolithography

This section describes how to set up the Nanolithography option on your instrument.

Setting up the Nanolithography option consists of the following general procedures:

♦  making sure that you have the components required for set up

♦  installing the Nanolithography software

♦  modifying your instrument for the lithography technique you plan to use

The sections below describe the above-listed procedures in detail.

Required Components

The Nanolithography option consists of the following components:

♦ a set of software diskettes for Windows 95 or Windows 3.1

♦ an AutoProbe Extended Signal Access Package (eSAP) low-voltage module (LVM)

(for M5 and for CP and LS instruments without an EC/Norm switch on the rear panel

of the base unit)

♦ AutoProbe Extended Signal Access Package Operation and Reference Guide (for

M5; and for CP and LS instruments that require an LVM)

The Nanolithography software must be run in tandem with ProScan Version 1.5.  If you

do not have ProScan Version 1.5, please contact the Customer Support Department.

Installing Nanolithography Software

This section describes how to install the Nanolithography software on your system.  The

software diskettes for Nanolithography include an automatic installation program that

uses a disk compression utility.  The installation program is contained on two

high-density diskettes.  The diskettes are labeled in accordance with the operating system

under which they should be installed Windows 95 or Windows 3.1.  Follow the

procedures in this section that are appropriate for operating system.

Important!  Before you install the Nanolithography software on your system,

you must install ProScan Version 1.5.  If you do not have ProScan Version 1.5,

contact the Customer Support Department.

For Windows 95, follow these steps to install the Nanolithography software:

1. Insert the Nanolithography software diskette labeled "Disk 1 for Windows 95"

into the a: drive of your computer.  (If you use the b: drive instead, substitute b

for a in the following procedures.)



6 Nanolithography Operating Instructions

THERMOMICROSCOPES

2. There are two ways to install the Nanolithography software under Windows 95:

1) using the Run command; or 2) using the Add/Remove Programs icon in the

Control Panel.

To install Nanolithography using the Run command, follow these steps:

a. Click the Start  button.

b. Next click Run.

c. The Run dialog box opens. Enter a:\setup.exe in the Open listbox and then

click the OK  button.

To install Nanolithography using the Add/Remove Programs icon in the Control

Panel, follow these steps:

a. Click the Start  button.

b. From the Start menu point to Settings and click Control Panel.

c. Double click the Add/Remove Programs icon.

d.  The Add/Remove Programs dialog box opens. Click the Install  button in

the dialog box.

e. Next, the Install Program from the Floppy Disk or CD-ROM dialog box

opens.  Click the Next  button.

f.  The Run Installation dialog box appears, displaying the command line for

the installation program a:\setup.exe. Click the Finish  button to begin the

installation of Nanolithography.

3. The Setup dialog box opens with the following message: "Copying Initialization

Files." The installation program places the Nanolithography software files into

the directory c:\psi\litho.  The directory c:\psi\litho is a subdirectory of ProScan.

The directories for the Nanolithography software are listed in Table 1, below.

Table 1.  Nanolithography directories.

Directory Files

c:\psi\litho lithography executable files

c:\psi\litho\bitmaps bitmap files

c:\psi\litho\scripts lithography parameter files

The installation program creates a folder called "PSI Nanolithography" in the

Program folder of the Start menu.
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4. The Nanolithography Setup window appears on the screen.  The default

directory for the software files c:\psi\litho is displayed in the window.

The installation program gives you the option of renaming the directory

c:\psi\litho.  We strongly suggest that you do not rename this directory, since it

will cause confusion when future versions of Nanolithography are released.

5. Click the Computer button to continue the installation process.

6. The installation program will ask for Disk 2.  Insert the diskette labeled "Disk 2

for Windows 95" into your floppy drive.  Then click the OK  button to continue

the installation process.

When installation of the Nanolithography software is complete, the installation program

returns to the Desktop.

For Windows 3.1, follow these steps to install the Nanolithography software:

1. Insert the Nanolithography software diskette labeled "Disk 1 for Windows 3.1"

into the a: drive of your computer.  (If you use the b: drive instead, substitute b

for a in the following procedures.)

2. In the Program Manager, from the File menu select Run. Enter a:\setup in the

Command Line textbox and then click the OK  button.

3. The Setup dialog box appears with the following message: "Copying

Initialization Files." The installation program places the Nanolithography

software files into the directory c:\psi\litho.  The directory c:\psi\litho is a

subdirectory of ProScan.  The directories for the Nanolithography software are

listed in Table 2, below.

Table 2.  Nanolithography directories.

Directory Files

c:\psi\litho lithography executable files

c:\psi\litho\bitmaps bitmap files

c:\psi\litho\scripts lithography parameter files

The installation program creates a new program group called "PSI

Nanolithography" in the Program Manager.
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4. The installation program will ask for Disk 2.  Insert the diskette labeled "Disk 2

for Windows 3.1" into your floppy drive and then click the OK  button to

continue the installation process.

5. The Nanolithography Setup window appears on the screen.  The default

directory for the software files c:\psi\litho is displayed in the window.

The installation program gives you the option of renaming the directory

c:\psi\litho.  We strongly suggest that you do not rename this directory, since it

will cause confusion when future versions of Nanolithography are released.

6. Click the Computer button to continue the installation process.

When installation of the Nanolithography software is complete, the installation program

returns to the Program Manager.

Configuring Nanolithography:  AutoProbe M5

This section includes step-by-step instructions for configuring AutoProbe M5 for use

with the Nanolithography option. The configuration you use depends on the lithography

technique you wish to design.  Note the following:

♦ No reconfiguration of the instrument or the software is required for z

scanner-movement lithography.

♦ A reconfiguration of the software is required for voltage-pulse lithography with a

sample bias voltage up to ±8 V.

♦ A reconfiguration of the hardware using an eSAP LVM and an external amplifier is

required for voltage-pulse lithography for a sample bias voltage greater than ±8 V.

To reconfigure the software for voltage-pulse lithography using a sample bias voltage up

to ±8 V, follow these steps:

1. Open the Nanolithography software as you normally do.

2. Select Instruments from the Setup menu.  The Instrument Output Control dialog

box opens.

3. Select the DAC 3 option button in the Instrument Output Control dialog box.

DAC 3 provides access to the sample bias voltage signal.
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To reconfigure the hardware for voltage-pulse lithography using a sample bias voltage

greater than ±8 V, follow these steps:

1. Configure the LVM for use with Nanolithography so that the voltage from the

external amplifier can be applied to the sample bias voltage signal via one of the

8 BNC connectors on the LVM.  For complete details on configuring the LVM,

refer to the AutoProbe Extended Signal Access Package Operation and

Reference Guide.

a. Place the LVM on a flat surface.  At this point, the LVM should NOT be

connected to the instrument.

b. Remove the cover of the LVM by loosing the two screws at each end using

an appropriately sized allen wrench.  The screws are located above the

electrical connectors at each end of the LVM.  Lift off the cover.

c. Inside the LVM is a PCB (printed circuit board) with eight I/O BNCs, a

series of jumper blocks that can be removed in order to break connections

through the board, eight differential amplifiers, and a total of 136

connection points (two associated with each of the eight BNCs, four

associated with each of the eight differential amplifiers, and 88 test points).

d. Configure a BNC for input from the external amplifier and connect the I/O

test point to test point 42 (sample bias voltage).

e. Place the cover over the BNC connectors and secure it using the two allen-

head screws

Warning!

Never make connections to the LVM with the cover off.

2. Install the reconfigured LVM as follows:

a. TURN OFF THE POWER to the computer and the AEM (AutoProbe

Electronics Module).  The on/off switch for the computer is located on the

front panel of the computer unit.  The on/off switch for the AEM is located

on its front panel.

b. Disconnect the 44-pin I/O cable from the rear panel of the AEM.

c. Plug the 44-pin I/O cable into the appropriate 44-pin connector on the

LVM.  This connects the interface module to the LVM.

d. Plug the 10" 44-pin I/O cable into the 44-pin connector of the AEM.  Then

plug the other end of the 10" 44-pin I/O cable into the 44-pin connector of

the LVM.  This connects the AEM to the LVM.

3. Connect a BNC cable to the output BNC configured above in Step 1.  Connect

the other end of the BNC cable to the input of an external amplifier.  The

external amplifier supplies voltage to the sample via the sample holder.
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4. Check that the LVM is securely attached to the M5 instrument.  Make sure that

the BNC cable is securely fastened to the BNC connector.

Configuring Nanolithography:  AutoProbe VP2

 This section includes step-by-step instructions for configuring AutoProbe VP2 for use

with the Nanolithography option. The configuration you use depends on the lithography

technique you wish to design.  Note the following:

♦ No reconfiguration of the instrument or the software is required for z

scanner-movement lithography.

♦ A reconfiguration of the software is required for voltage-pulse lithography in STM

mode.  (Voltage-pulse lithography is not available in AFM mode.)

Note:  The procedures described in this section also apply to AutoProbe VP.

To configure the software for voltage-pulse lithography in STM mode, follow these

steps:

1. Open the Nanolithography software as you normally do.

2. Select Instruments from the Setup menu.  The Instrument Output Control dialog

box opens.

3. Enable the DAC 3 option button in the Instrument Output Control dialog box.

DAC 3 provides access to the sample bias voltage signal.

Your instrument should now be configured for voltage-pulse lithography in STM mode.
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Modifying a Sample Surface Using Nanolithography

This tutorial teaches you the basics of using the Nanolithography option to design a

lithography technique.  This tutorial provides general guidelines for modifying a sample

surface in contact-AFM mode. The lithography technique you design and use in this

tutorial is z scanner-movement lithography.  The sample you use in this tutorial depends

on your interests.  In general, we suggest that you choose a sample that is somewhat soft

in composition so that the surface can be easily modified using the lithography technique.

Instructions are included in this tutorial for AutoProbe CP, M5, and VP2.  This tutorial

assumes that you are familiar with the basics of using your instrument, such as loading a

probe head (for CP) or scanning head (for M5), a probe, and a sample.  This tutorial does

not provide details for these procedures.  Instead, it refers you to your User’s Guide where

applicable.

Note: The procedures that refer to AutoProbe CP are applicable to AutoProbe LS

instruments as well.  The procedures that refer to AutoProbe VP2 are applicable

to AutoProbe VP as well.

Designing the z scanner-movement lithography technique described in this tutorial

consists of the following general procedures:

♦ setting up the instrument for operation in contact-AFM mode and taking an image in

ProScan Data Acquisition

♦ opening and loading the image into the Nanolithography software

♦ defining important parameters for the lithography technique using Nanolithography

software tools

♦ creating a lithography pattern using Nanolithography software tools

♦ saving the parameters and the pattern for the lithography technique using

Nanolithography software tools

♦ writing the pattern on the sample surface using Nanolithography software tools

♦ reimaging the sample in ProScan Data Acquisition to see how it was modified

The above-listed procedures are described in detail in the sections below.  Follow the

procedures in the sections that are appropriate for your instrument.
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Setting Up the Instrument for AFM:  AutoProbe CP

To set up AutoProbe CP for operation in contact-AFM mode, follow these steps:

1. Install a scanner as described in the User’s Guide.

2. Secure a sample onto a sample mounting disk with a hard glue, for example

epoxy.  Place the sample mounting disk onto the sample holder of the scanner as

described in the User’s Guide.

3. Install one of the probe heads (AFM/STM, AFM/LFM, or AFM/NCM) onto the

XY stage as described in the User’s Guide.

4. Insert a premounted, contact Ultralever probe cassette into a contact-AFM probe

cartridge.  See Part I of the User’s Guide for details.

5. Insert the probe cartridge into the probe head as described in Part I of the User’s

Guide.

6. Turn on the power to the AEM.  Then, turn on the power to the computer.

7. Turn on the power to the color video monitor.

8. Open ProScan Data Acquisition as you normally do.

9. Align the deflection sensor as follows:

a. Turn on the power to the probe head by clicking the Head ON icon, .
b. Locate and focus on the cantilever using the optical view as described in

Part I of the User’s Guide.

c. If the laser beam is not reflecting off the back of the cantilever tip, then you

need to adjust the position of the laser.  Use the two laser beam steering

screws to move the laser.  Move the laser until you can see a red spot on the

back of the cantilever.
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d. When the laser spot is reflecting off of the back of the cantilever, adjust the

laser position on the PSPD to maximize the laser intensity using the PSPD

forward/backward and PSPD up/down screws.

Note: Maximum laser intensity is indicated differently on different probe

heads (for example, AFMSTM or AFMLFM).  See the User’s Guide

for details.

10. Configure the software for contact-AFM as follows:

a. If the probe head is turned on, turn it off now by clicking the Head ON icon

.

b. Select Configure Parts from the Setup menu, or click the Configure Parts

icon .  The ProScan Database Configuration dialog box will open.

c. Configure the software for operation in contact-AFM mode by making the

following selections in the dialog box:

♦ Head type: Select the probe head type that you have installed.

♦ Scanner:  Select the file that has the calibration parameter values for the

scanner that you have installed (e.g., select "100UM" for a 100µm

scanner).

♦ Head mode: AFM.

♦ Beam bounce cantilever:  Select the file that corresponds to the

cantilever you are using (e.g., select "UL06B" if you are using the B

cantilever of a contact Ultralever).

♦ Electrochemistry ON/OFF: OFF.

♦ Voltage mode: HI.

d. Click the OK  button to close the dialog box.

Next you will take an AFM image of the sample surface.  Go to the section "Taking an

AFM Image."
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Setting Up the Instrument for AFM:  AutoProbe M5

To set up AutoProbe M5 for operation in contact-AFM mode, follow these steps:

1. If a scanning head is installed on your instrument, remove it as described in Part

I of the User’s Guide.

2. Install a premounted, contact Ultralever probe cassette onto the spring clip of the

scanning head as described in the User’s Guide.

3. Install the scanning head on your instrument as described in the User’s Guide.

4. Set the NCAFM switch on the front panel of the interface module to the

NC-AFM position.  This selection makes contact-AFM operation available.

5. Place a sample onto the sample chuck as described in the User's Guide.

6. Turn on the power to the AEM.  Then, turn on the power to the computer.

7. Turn on the power to the color video monitor.

8. Open ProScan Data Acquisition as you normally do.

9. Align the deflection sensor as follows:

a. Turn on the scanning head by clicking the Head ON icon .
b. Locate and focus on the cantilever using the optical view as described in

Part I of the User’s Guide.

c. If the laser beam is not reflecting off the back of the cantilever tip, then you

need to adjust the position of the laser.

d. Use the laser adjustment lever to center the spot on the laser.  The laser

adjustment lever positions the laser coarsely in the x and y directions.

e. When the laser spot is reflecting off of the back of the cantilever tip, adjust

the laser position on the PSPD using the AFM control screw.

10. Configure the software for contact-AFM as follows:

a. If the scanning head is turned on, turn it off now by clicking the Head ON

icon .

b. Select Configure Parts from the Setup menu.  Alternatively, click the

Configure Parts icon .  The ProScan Database Configuration dialog box

will open.

c. Configure the software for operation in contact-AFM mode by making the

following selections in the dialog box:
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♦ M5 Head Scanner:  Select the file that has the calibration parameter

values for the scanning head that is installed.

♦ M5 Mechanical Switch:  AFM/NCM

♦ Head mode:  AFM.

♦ Beam bounce cantilever:  Select the file that corresponds to the

cantilever you are using (e.g., select "UL06B" if you are using the B

cantilever of a contact Ultralever).

♦ Electrochemistry ON/OFF:  OFF.

♦ Voltage mode:  HI.

d. Click the OK  button to close the dialog box.

Next you will take an AFM image of the sample surface.  Go to the section "Taking an

AFM Image."
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Setting Up the Instrument for AFM:  AutoProbe VP2

This section assumes that the UHV head is mounted onto the protective cover or the

vacuum chamber.

To set up AutoProbe VP2 for operation in contact-AFM mode, follow these steps:

1. Turn on the interface module.  The on/off button is a red button labeled POWER

on the front panel of the interface module.

2. Set the PROBE knob on the front panel of the interface module to the AFM

position.  This selects the contact-AFM mode of operation.

3. Turn on the power to the AEM.  Then, turn on the power to the computer.

4. Load a sample onto the sample holder as you normally do.

5. Load an AFM probe onto the scanner contact pad as described in the User’s

Guide.

6. Open ProScan Data Acquisition as you normally do.

7. Configure the software for contact-AFM as follows:

a. If the power to the scanner is turned on, turn it off now by clicking the Head

ON icon .

b. Select Configure Parts from the Setup menu.  Alternatively, click the

Configure Parts icon .  The ProScan Database Configuration dialog box

will open.

c. Configure the software for operation in contact-AFM mode by making the

following selections in the dialog box:

♦ VP Scanner:  Select the file that contains the calibration parameters for

the scanner that is installed.

♦ VP Analog\Digital Switch:  DIGITAL.

♦ VP Mode Switch:  AFM.

♦ Piezo Cantilever:  Select the filename that corresponds to the cantilever

you are using (for example, select PL20 if you are using a contact

Piezolever)

♦ Voltage Mode:  HI.

d. Click the OK  button to close the dialog box.

The next section describes how to take an AFM image.
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Taking an AFM Image

To take an AFM image, do the following:

1. Perform an auto approach.

a. For VP2, unlock the vibration isolation stage as described in Part I of the

User’s Guide.

b. Click the Approach  button in Move mode to initiate an auto approach.

c. After the tip has engaged the sample, switch to Image mode by selecting

Image Mode from the Mode menu.  Or, click the Image mode icon .

2. Select the Topography signal to collect topography data.

a. From the Setup menu select Input Config to open the Input Configuration

dialog box.  Alternatively, click the Input Config icon .

b. The Topography signal should be selected by default.  If it is not, in the

Available Signals listbox select Topography and then click the Add -->

button.  This enables you to collect topography data and to monitor the

Topography signal on the Oscilloscope Display.

c. Click the OK  button to close the Input Configuration dialog box.

3. Select scan and feedback parameters as you normally do (e.g., the scan rate).

Make sure that the Z servo checkbox is enabled.  When the Z Servo checkbox is

enabled, the z feedback loop is on and an image of surface topography is

generated.

4. Check to be sure that the Save to Buffer icon (  ) is ON, or that the Save to

Buffer menu item of the Mode menu is selected.  This sets the image you

acquire to be saved on your hard disk.  By default, the image is be saved to the

directory c:\spmdata, unless you specify otherwise in the New Session dialog

box.

5. Click the Image  button to start a scan.

A topography AFM image will be built up in the Active Display.
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Starting Nanolithography and Loading an Image

This section describes how to start Nanolithography and how to load the AFM image you

just acquired in Data Acquisition into the Nanolithography software.

1. Open Nanolithography as you normally do.

The Nanolithography window is divided into several regions.  The image you work with

will be displayed at the center of the window, in the Image Display.  Above the Image

Display is a Menu bar, which contains menus that are used in the design and the

implementation of lithography techniques.  Below the Image Display is a Status bar,

which contains information about the image.  Information can include the image file

name and the parameters used to acquire the image, such as the scan size.  At the right of

the Image Display are Pattern and Object controls, which are used to create lithography

patterns.

2. Load the AFM image that you acquired in Data Acquisition as follows:

a. From the Insert menu select SPM Image.  The Open dialog box will appear.

b. Select the directory where the image you just acquired is stored.  By default,

this directory is c:\spmdata, unless you specified otherwise in the New

Session dialog box.

c. Select the file name of the image.  Then click the Open  button.

Before the image is loaded into the software, a 1st order polynomial fit is automatically

applied to the image.  The 1st order polynomial fit removes slope in the image in the x

and y directions.  The circular red light in the upper-right corner of the window blinks

while the 1st order polynomial fit is performed on the image.  When the software

completes the fit, the image will be loaded into the Image Display.

The scan size of the image is listed in the Width (µm) and Height (µm) textboxes.  The

number in the Width (µm) textbox represents the scan size in the horizontal (i.e., the x)

direction.  The number in the Height (µm) textbox represents the scan size in the vertical

(i.e., the y) direction.

The number of data points used to collect the image is listed in the X Points and Y Points

textboxes.  The number in the X Points textbox represents the number of data points

collected in the horizontal (i.e., the x) direction.  The number in the Y Points textbox

represents the number of data points collected in the vertical (i.e., the y) direction.
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Defining Important Parameters

Parameters for lithography must be defined before you create a lithography pattern.  The

parameters you set determine the lithography technique voltage-pulse lithography or z

scanner-movement lithography.  In this section you define parameters that are appropriate

for z scanner-movement lithography.

1. From the Setup menu select Tools.  The Tools Setup dialog box will appear.

2. Enable the Point Setup option button.  This displays parameters that you may

want to set for a pattern that consists of points.

3. Set up z scanner-movement lithography as follows:

a. Make sure that the Z Scanner checkbox is enabled (i.e., checked).  This

enables you to define movement of the scanner in the z direction.  The z

range for the scanner that is installed on your system is listed in the Z

Scanner Range textboxes.

b. The default z position of the scanner is listed in the Default (µm) textbox.

For this tutorial, enter a value of 0 in the textbox.  This sets the z position of

the scanner to the middle of its range.

c. The position that the scanner extends to at each point in the pattern is listed

in the Move To (µm) textbox. Enter the z position in the textbox that you

want the scanner to extend to.  Again, the position that you select depends

on the characteristics of your sample.

d. Enter a value of 1 in the Approach (N) textbox.  This sets the number of

steps that the scanner uses to approach the sample before an object in a

pattern (e.g., a point) is "written" on the sample.

e. Make sure that the Z Servo checkbox is not enabled (i.e., checked).  For z

scanner-movement lithography, the feedback loop must be disabled.

f. Disable (i.e., uncheck) the Sample Bias checkbox.  The Sample Bias

checkbox should only be enabled when you want to apply a bias voltage

between the tip and the sample, for example in voltage-pulse lithography.

4. The Speed µm/second textbox lists the speed at which the lithography pattern is

written on the sample.  For a pattern that consists of points the optimum value is

around 3 µm/second.

5. Click the Update  button to refresh the parameters in the dialog box.

6. Click the OK  button to close the dialog box.
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Selecting the Lithography Pattern

There are four Pattern controls that can be used to create a lithography pattern.  These

controls include the following:

♦ a Point icon for creating points

♦ a Vector icon for creating vectors

♦ a Grid icon for creating grids

♦ a Bitmap icon for importing bitmap (.bmp) images

In this section you will learn how to create a pattern that consists of points.  Points are

created at x, y locations on the image in the Image Display.

1. Select the point shape by clicking the Point icon.

2. To define the location of a point, use the mouse to place the cursor over an

x, y location in the image.  Then double click the mouse button.  A red circle

will be displayed on the image at the selected x, y location.

When you define a point, the Width (µm) and Height (µm) textboxes are replaced by X0

(µm) and the Y0 (µm) textboxes.  The X0 (µm) textbox displays the x coordinate of the

point.  The Y0 (µm) textbox displays the y coordinate of the point.

3. You can define multiple points in the image by repeating step 2 above.

4. If you wish to delete a point in the image, double click the desired point.  The

point will be removed from the image.

Updating Parameters for the Lithography Pattern

When you want to change the parameters for an object in a pattern, you must update the

parameters in the Tools Setup dialog box.  This section describes this procedure.

1. Click the icon in the Pattern controls that represents the object for which you

want to define new parameters.  In this tutorial if you wish to change the

parameters for a point you click the Point icon.

2. Click the desired object in the image (e.g., a point).

3. Change the desired parameters in the Tools Setup dialog box.  See the section

"Defining Important Parameters" in these operating instructions for details.
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Saving the Lithography Technique

The parameters and the pattern that constitute a lithography technique can be saved as a

lithography file (.lit).  By default, lithography files are stored in the directory

c:\psi\litho\scripts.  Lithography files can be retrieved at any time.

To save the lithography technique you defined in this tutorial, follow these steps:

1. From the File menu select Save.  The Save As dialog box will appear.

2. Select the drive and the directory where you want to store the lithography file.

By default, lithography files are saved in the directory c:\psi\litho\scripts.  In

general, we recommend that you store any lithography files you create in this

directory so that they can be easily located and retrieved.

3. Enter a name for the lithography technique in the File Name textbox and the file

extension .lit.

4. Click the Save  button to save the lithography technique and close the dialog

box.

Executing the Lithography Technique

1. Go to ProScan Data Acquisition.  To obtain control of the Nanolithography

software, do the following:

a. Disable (i.e., uncheck) the Z Servo checkbox in Image mode.  This disables

the z feedback loop.

b. Open X-Y Trace by selecting X-Y Trace from the Tools menu.

2. Implement the lithography technique as follows:

a. From the Lithography menu select Start.

b. The Lithography Check Off dialog box will appear, containing several

important warnings.  After you read these warnings click the OK  button to

close the dialog box.

c. The SPMRUN dialog box will open.  The SPMRUM dialog box displays

the command lines for the selected lithography technique.  The SPMRUN

dialog box will close when the software has performed the lithography

technique.

The pattern you created should now be written on the sample surface.
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Re-imaging the Modified Sample

To see the effects of the lithography technique, you can reimage the sample.  The image

of the sample surface should show the pattern.

1. Click the Image  button to start a scan.

A topography AFM image will be built up in the Active Display.  Look at the image.  See

if you can identify the location of the points (or, holes) on the sample surface.
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Nanolithography Software Reference

This section of the operating instructions is the reference manual for the Nanolithography

software.  The sections begins with a description of the controls in the Nanolithography

window.  Then, menus are introduced, with special attention given to each menu item.

This section is designed so that you can skip straight to the software feature (i.e., the

control or the menu) that you are interested in.

Note: If you are new to Nanolithography, you should begin with the tutorial

"Modifying a Sample Surface Using Nanolithography" earlier in these operating

instructions.  The tutorial gives you the basic skills you need to use

Nanolithography.  Then, you can return to this section to learn more about

specific software features.

To open Nanolithography, do the following:

♦ For Windows 95:  From Start, click PSI Nanolithography in the Program folder.

♦ For Windows 3.1:  Double click the PSI Nanolithography icon in the Program

Manager.

The Nanolithography window is shown in Figure 1, below.

Figure 1.  The Nanolithography window.
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Nanolithography Controls

The Nanolithography window is divided into several regions.  The window includes the

Image Display, Pattern controls, Object controls, a Menu bar, and a Status bar.

The Image Display is located at the center of the window.  Images that are loaded into

Nanolithography are displayed in the Image Display.

The Pattern (Pat) controls are displayed to the right of the Image Display.  Pattern

controls are used for creating objects that constitute a lithography pattern (for example, a

point or a grid).

The Object controls are displayed to the right of the Image Display.  Object controls

display the scan size and the number of data points for the image in the Image Display.

When you select an object in the Pattern controls, the Object controls allow you to adjust

the size and the location of an object.

The Menu bar is located above the Image Display.  The Menu bar includes a list of

menus, which contain menu items for controlling Nanolithography.  The next section,

"Nanolithography Menus," describes in detail each menu in the Menu bar.

The Status bar is located below the Image Display.  The Status bar displays information

about the image in the Image Display.  Information can include the image file name and

the parameters used to generate the image, such as the scan size.

Some of the above-mentioned regions of the Nanolithography window are discussed

further in the sections below.
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Pattern Controls

The Pattern (Pat) controls include the following:

♦ a Point icon for creating points

♦ a Vector icon for creating vectors

♦ a Grid icon for creating grids

♦ a Bitmap icon for importing bitmap (.bmp) images

The above-listed controls are used to create objects in a lithography pattern.  The function

of each Pattern control is summarized in the Table 3, below.

Table 3.  Pattern controls.

Control Function

Background Loads the most recently saved image from a specified directory into the

Image Display.  The directory that images are loaded from is set up using

the Directories menu item of the Setup menu.

Point Allows you to define a point in the image in the Image Display.

Vector Allows you to define a vector in the image in the Image Display.

Grid Allows you to define a grid in the image in the Image Display.

Bitmap Allows you to load a previously saved bitmap (.bmp) image into the

Image Display.

To load the most recently saved image into the Image Display using the Background

control:  Set up the directory that you want to load images from using the Default

Directories dialog box.  To open this dialog box, from the Setup menu select Directories.

In the SPM Image textbox enter the path for the directory where the image you just

acquired is stored.  Then click the OK  button to close the dialog box.  Double click the

Background icon.  The image that was most recently saved to the directory specified in

the Default Directories dialog box will be loaded into the Image Display.

To create a point in the image in the Image Display:  Click the Point icon.  Use the mouse

to place the cursor over the x, y location in the image where you want to define a point.

Then double click the mouse button.  A red circle indicates the location of the point.

Repeat this procedure to define multiple points.



26 Nanolithography Operating Instructions

THERMOMICROSCOPES

To change the location of a point:  Click the desired point and drag it to a new x, y

location in the image.  Alternatively, in the X0 (µm) and Y0 (µm) textboxes enter the x

and y coordinates, respectively, for the point’s location.  Click the Update  button to

move the point to its new location.

To delete a point:  Double click the point that you wish to delete.  The point will be

removed from the image.

To create a vector in the image in the Image Display:  Click the Vector icon.  Use the

mouse to place the cursor over the x, y location where you want the vector to begin.

Click at that location and drag the cursor to the x, y location where you want the vector to

end.  The vector is displayed as a red line, with an arrow at the x, y location where the

vector terminates.  Repeat this procedure to define multiple vectors.

To change the location of a vector:  Click the desired vector.  To change the location

where the vector begins, in the X0 (µm) and Y0 (µm) textboxes enter new x and y

coordinates, respectively.  To change the location where the vector ends, in the

X1 (µm) and Y1 (µm) textboxes enter new x and y coordinates, respectively.  Click the

Update  button to update the vector’s position.

To delete a vector:  Double click the vector that you wish to delete.  The vector will be

removed from the image.  Repeat this procedure to delete multiple vectors.

To define a grid in the image in the Image Display:  Double click the Grid icon.  By default,

a grid is displayed in the upper-left corner of the image.  Repeat this procedure to define

multiple grids.

To resize a grid:  Use the mouse to place the cursor on one of the four corners of the grid.

The cursor will change to a double arrow.  Click and drag the double arrow until the grid

is the desired size.  Alternatively, change the grid’s size in x and y by entering new values

in the Width (µm) and Height (µm) textboxes, respectively.  Click the Update  button to

update the grid’s size.

To change the location of a grid:  Use the mouse to place the cursor at the center of the

grid.  Then click and drag the grid to the desired location.

To delete a grid:  Use the mouse to place the cursor over the grid that you wish to delete.

Then click the Delete  button.  The grid will be removed from the image.  Repeat this

procedure to delete multiple grids.
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To load a bitmap image into the image in the Image Display:  Double click the Bitmap icon.

The Open dialog box will open, allowing you to load a previously saved bitmap file from

any drive or directory into the Image Display.  Select the file name of the bitmap (.bmp)

image that you want to load and then click the Open  button.  The bitmap image will be

enclosed in a black box.  Repeat this procedure to load multiple bitmap images.

To resize a bitmap image:  Use the mouse to place the cursor on one of the four corners of

the black box that encloses the bitmap image.  The cursor will change to a double arrow.

Click and drag the double arrow until the bitmap is the desired size.  Alternatively,

change the bitmap image’s size in x and y by entering new values in the Width (µm) and

Height (µm) textboxes, respectively.  Click the Update  button to update the bitmap

image’s size.

To change the location of a bitmap image:  Use the mouse to position the cursor at the

center of the black box that encloses the bitmap image.  Click and drag the bitmap image

to the desired location.

To delete a bitmap image:  Use the mouse to place the cursor over the bitmap image that

you want to delete.  Then click the Delete  button.  The bitmap image will be removed

from the image.  Repeat this procedure to delete multiple bitmap images.

Object Controls

The Object controls display information about the image in the Image Display.

Information includes the scan size and the number of data points used to generate the

image.  The function of each Object control is summarized in the Table 4, below.
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Table 4.  Object controls.

Control Function

Resize This control is currently not used.

Full Size Expands a grid to include the entire image in the Image Display.

Update Updates the size and/or the location of an object (for example, a point) in

the image in the Image Display.

Delete Deletes a selected grid or bitmap image from the image in the Image

Display.

Width (µm) Lists the scan size of the image in the Image Display in the x direction.

Height (µm) Lists the scan size of the image in the Image Display in the y direction.

dx Displays the number of data points used to collect the image in the Image

Display in the x direction.

dy Displays the number of data points used to collect the image in the Image

Display in the y direction.

When you define an object in the image, the Object controls on the screen are replaced by

new controls.  The new controls are specific to the object you define.  For instance, when

you define a point in the image the Object controls enable you to enter x and y

coordinates for that point.  The controls for each object type are listed in Table 5 through

Table 7, below.

The Object controls for a point are listed in Table 5, below.

Table 5.  Point controls.

Control Function

X0 (µm) Enables you to enter a point’s x location.

Y0 (µm) Enables you to enter a point’s y location.
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The Object controls for a vector are listed in Table 6, below.

Table 6.  Vector controls.

Control Function

X0 (µm) Enables you to enter a vector’s starting location in x.

Y0 (µm) Enables you to enter a vector’s starting location in y.

X1 (µm) Enables you to enter a vector’s ending location in x.

Y1 (µm) Enables you to enter a vector’s ending location in y.

The Object controls for a grid and a bitmap are the same and are listed in Table 7, below.

Table 7.  Grid and bitmap controls.

Control Function

Width (µm) Enables you to enter a grid or bitmap image’s size in x.

Height (µm) Enables you to enter a grid or bitmap image’s size in y.

To change the location of a point:  Click the desired point.  In the X0 (µm) and Y0 (µm)

textboxes, enter the point’s x and y coordinates, respectively.  Click the Update  button to

update the point’s location.

To change the location of a vector:  Click the desired vector.  To change the vector’s

starting location, in the X0 (µm) and Y0 (µm) textboxes enter x and y coordinates,

respectively.  To change the vector’s ending location, in the X1 (µm) and Y1 (µm)

textboxes enter x and y coordinates, respectively.  Click the Update  button to update the

vector’s position.

To resize a grid:  Click the desired grid.  In the Width (µm) and Height (µm) textboxes

enter new x and y values , respectively, for the grid’s size.  Click the Update  button to

update the grid’s size.

To resize a bitmap image:  Click the desired bitmap.  In the Width (µm) and

Height (µm) textboxes enter new x and y values , respectively, for the bitmap image’s

size.  Click the Update  button to update the bitmap image’s size.
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Nanolithography Menus

The Nanolithography Menu bar contains a list of menus.  The menus include the

following:

♦ File ♦ Lithography

♦ Edit ♦ Setup

♦ Insert ♦ Help

These menus contain menu items, which give you access to lithography controls as

illustrated in Figure 2, below.

Figure 2.  Nanolithography Menus.

The menus and menu items are described in detail in the sections below.

File Menu

The File menu contains menu items for opening and saving lithography files (or,

lithography scripts).  Lithography files contain parameters and patterns for lithography

techniques.  Lithography files use the file extension .lit.

File menu items include the following:

♦ New ♦ Save As

♦ Open ♦ Exit

♦ Save

The above-listed menu items are described in Table 8, below.
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Table 8.  File menu items.

Menu item Function

New Clears the pattern shown in the image in the Image Display.

Open Displays the Open dialog box, which allows you to load a previously

saved lithography file (.lit) into the software.

Save Displays the Save dialog box, which allows you to save a lithography file

(.lit) in the default directory c:\psi\litho\scripts.

Save As Performs the same function as the Save menu item.

Exit Closes the Nanolithography software.

Edit Menu

The Edit menu contains a menu item for copying a lithography pattern to the Notepad

(Windows 95) or to the Clipboard (Windows 3.1).  Other menu items are currently not

enabled.

The Edit menu items that are displayed on the screen include:

♦ Undo Edit ♦ Copy

♦ Repeat Edit ♦ Paste

♦ Cut ♦ Paste Special

The Copy menu item copies the lithography pattern for the image in the Image Display to

the Notepad (Windows 95) or to the Clipboard (Windows 3.1).  You can then paste the

lithography pattern into any third-party software application.

Insert Menu

The Insert menu contains menu items for loading an image into the Image Display and

creating a custom color map.  Insert menu items include the following:

♦ Insert

♦ Histogram

The above-listed menu items are described in Table 9, below.
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Table 9.  Insert menu items.

Menu item Function

Insert Opens the Open dialog box, which allows you to load an image from any

drive or directory into the Image Display.

Histogram Opens the Chameleon dialog box, which allows you to create a custom

color map for the image in the Image Display.

Lithography Menu

The Lithography menu contains menu items for starting and stopping lithography

techniques.  Lithography menu items include the following:

♦ Export

♦ Start

♦ Stop

The above-listed menu items are described in Table 10, below.

Table 10.  Lithography menu items.

Menu item Function

Export This menu item is currently not enabled.

Start Starts the implementation of a lithography technique.

Stop Stops the implementation of a lithography technique.

Setup Menu

The Setup menu contains menu items for defining lithography parameters and for

managing lithography files.  Setup menu items include the following:

♦ Tools ♦ Directories

♦ Pattern ♦ Colors

♦ Instruments

The above-listed menu items are described in Table 11, below.
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Table 11.  Setup menu items.

Menu item Function

Tools Opens the Tools Setup dialog box, which allows you to define parameters

for a lithography technique.  For example, you can choose a Point Setup

for use with points and bitmaps or a Continuos Line Setup for use with

vectors and grids.  You can also set Z Scanner parameters for z scanner-

movement lithography and Sample Bias parameters for voltage-pulse

lithography as well as the scanner speed.

Pattern Opens the Setup Pattern dialog box.  For a grid, the dialog box enables

you to select the method used to write lines of the grid on the sample

surface.  Lines of a grid can be written in the same direction or in

alternating directions.

Instruments Opens the Instrument Output Controls dialog box.  For M5 and VP2, the

includes for configuring the software to match the installed hardware.

See the section appropriate for your instrument in these operating

instructions:  "Setting Up Nanolithography:  AutoProbe M5;" or "Setting

Up Nanolithography:  AutoProbe VP2."

Directories Opens the Default Directories dialog box, which allows you to select the

default directories for the following files:  lithography files (.lit), bitmap

files (.bmp), and image files (.hdf).

Colors Opens the Chameleon dialog box, which allows you to create a custom

color map for the image in the Image Display.

Help Menu

The Help menu contains the About menu item.  The About menu item opens the About

dialog box, which lists the version of Nanolithography that is installed on your system.
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Summary

In these operating instructions, you learned:

♦ about the Nanolithography components

♦ about the different types of lithography techniques

♦ how to install Nanolithography software your system

♦ how to set up your system for use with Nanolithography

♦ how to modify a sample surface using z scanner-movement lithography in

contact-AFM mode

♦ about the Nanolithography software controls

Once you are familiar with the information provided in these operating instructions, you

should be ready to develop lithography techniques specific to your application.


